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I. Welcome  

        

Welcome to the Tamke-Allan Observatory Solar Observation Network.  TAOSON was conceived in 

2007 and operated for its first year as a student group directed by David Fields at TAO.  Other members 

were Heather Fries, now President of the Student Astronomy Association and President of Sigma Pi 

Sigma at ETSU and Tyler Moore, now in Naval Intelligence.  Both Heather and Tyler attended and 

presented papers at the SARA meeting.  In 2008 we opened up the group to the larger local amateur radio 

astronomy community.  

 

The primary purpose of TAOSON is to keep local radio astronomers in touch and help coordinate their 

activities as they maintain their radio astronomy research sites. To this end we maintain a server for 

storing and sharing data, schedule meetings each month, and assist each other when needed.  Most 

members support the Society of Amateur Radio Astronomers (see www.radio-astronomy.org). 

 

TAOSON participates in the TAO Academic Associates of colleges and universities where members 

share research and scientific goals. This is both science and a humanistic endeavor that encourages 

cultural exchange. TAOSON also helps advise the TAO Space Explorer Groups with a common goal of 

developing capable and motivated human beings that will serve the community and become future 

scientists and contributors to a better world. 

 

Membership is free if you’re actively doing radio astronomy. Otherwise, membership is still free and you 

are invited to help with our projects.  Our major problem is lack of contributors to the Signal.  

II. Meetings 
 

TAOSON 

TAOSON had a great meeting with Tom Crowley’s visit (see below).  Our meeting format will usually 

include a brief tutorial on a radio astronomy topic of interest, a work session on some chosen task or 

topic, a meal or refreshments, and a brainstorming session about projects. 

 

Area Optical Astronomy Groups 

Oak Ridge Isochronous Observation Network (Orion) meets at 7:00 P.M. on the first Wednesday of each 

month The Club Room, Oak Ridge Civic Center. See www.roanestate.edu/obs and www.orioninc.org. 
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ORION met on April 6 and considered cosmogenic gamma pulses (by John Mannone) and energy sources 

(Bob Edwards). 

Save Roane Starry Skies had a meeting in Oak Ridge on April 6.  Roane County kids are going to be 

invited to come to TAO with paint ball guns and use our (to be constructed firing range. Targets will have 

targets with images of Bad (glaring, sky-unfriendly) lamps, andGood (light-conserving) lamps. This will 

be the big event of the year for SRSS. 

Barnard Astronomical Society (BAS) meets at 7:00 P.M. on the second Thursday of each month at the 

UT Chattanooga Clarence Jones Observatory. See BAS@chattanooga.net. 

 

III. The TAOSON Signal 

 

Our newsletter, the TAOSON Signal, will be published on a periodic basis as sufficient articles and other 

written contributions are received. Every effort will be made to protect the e-mail addresses on the 

distribution list and the privacy of their owners. Feel free to circulate and share copies of the Signal. 

Items for the newsletter will be submitted by e-mail to Editor Bill Seymour at swafseymo@bellsouth.net  

and to David Fields at fieldsde@aol.com. We encourage each active member to submit at least a 

paragraph that summarizes site activities, goals, and ideas. Members are also invited to submit questions 

to the Editor to be considered in the newsletter and at meeting. 

 

 

 

IV. Research Site Locations and Capabilities 

 

TAOSON sites include those shown on the following map and identified in the following FACILITIES 

DIRECTORY. 
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Site Location Site Name Code Control 

Operator 

Lat 

Long 

Telephone Operations 

1 Rockwood TAO TAO David 

Fields 

35.8322 

84.6175 

865-376-

1362 

21 cm, 15m, optical, Ku, 

Spectracyber, 

Interferometer, IBT 

2 Cleveland SkyNet SN Bill & 

Melinda 

Lord 

35.2427 

84.8783 

423-478-

9043 

21 cm, 15m, optical, Ku, 

Spectracyber, VLF 

(SID), FM Meteor, IBT 

3 Solway Solway SOL David 

Fields 

35.9641 

84.2021 

865-927-

5155 

15m, Ku (2), optical, 

VLF, H-alpha 

4 Hixson Riverbend RB Dick Castle  423-870-

4398 

15m 

5/7 Lenoir City Lenoir City LC Aaron 

Haun 

 865-986-

7153 

Server, 15 m 

6 Signal Mtn. Mountain MTN Bill 

Seymour 

 423-870-

8552 

15m, optical, Ku, VLF 

(SID), IBT 

8 Blue Meadow Blue 

Meadow 

BLM Linda 

Fippin 

 865-539-

0826 

VLF 

9 Niota Niota CL John 

Mannone 

 423-337-

2197 

Ku, Optical, VLF, IBT 

10 Karns Karns KA Carl Lyster   Spectracyber, VLF 

11 Johnson   City Johnson 

City 

JC Heather 

Fries 

  Quantitative optical, VLF 

(SID) planned 

Puerto Rico Puerto 

Rico 

PR Wanda 

Diaz 

  15 m, Spectracyber 

UNAM, MX Mexico UN Stan Kurtz   15m, Spectracyber, 

Homebrew IBT, SRT 
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V.Reports from The Sites 

 

TAO Site Report   David Fields 

 

Astronomers, 

Our guest astronomer from Chiefland Astronomy Village, Tom Crowley, gave two excellent talks in 

April. We had a full crowd for both. The first presentation, “Advances in Amateur Radio 

Astronomy” covered recent advances in radio astronomy that permit amateur astronomers to contribute 

actively to astronomy research.  Current observations showing changes in solar output were discussed. 

After this excellent talk, part of the afternoon (geeky) crowd went to Gondolier and we had a great meal. 

Here's part of the afternoon crowd. The night crowd was bigger but I haven't received anyone's photos 

yet. If you have any, please send me a copy.  

 

  

Tom's second presentation, “Searching for Super Novas,” started at 7:30 PM. Tom is a member of the 

Puckett Observatory Super Nova Search Team and they have discovered over 170 super novas. This 

presentation covered different classifications of super novas; described how the amateur astronomer hunts 
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them, and what procedures need to be followed to report their discovery. Besides super nova hunting with 

his homebuilt 24” telescope, Tom does visual observing, CCD imaging and radio astronomy.  Most of 

their photos are made using Jack Newton's scope for remote photos. The night talk was packed, but 

outside skies were cloudy -- not even sucker holes.  

Roy Morrow has a western h ome near Jack Newton's and was over there last week. Roy, Heather, and 

the rest of you who asked if someone could video tape Tom's presentations -- we had 2 video cameras 

going (thanks to Dick Castle and Bill Seymour, both of Chattanooga) so I think that we'll be able to get a 

copy.  Thanks to both of you! 

Come to think of it, we had more Chattanooga people there than SMAS people (yes, that's even including 

the fact that I'm a paid-up SMAS member). That's not the first time that this has happened.  Chattanooga 

is an active place! I was there a few weeks ago, when they had my friend Chuck Higgins speaking about 

observing Jupiter. Here we are admiring the historic telescope on the UTC campus. 

 

We have some interest in the NASA LCROSS mission. Two lunar crater impacts are planned for Aug. or 

Sept., the first being a 2-ton Centaur rocket and the second, an instrumented probe. Analysis of the dust 

plume will provide composition data. 

 

I speculate that there may be active radio emission with good signal/noise, based on the following 

considerations: 

- we will know the impact time, so can look for a synchronous signal (pulse); 
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- active emission will be against a very low background, so S/N is good; 

- the impact will be at night for us (I hope) so there will be no large competing solar signal; 

- the impact vehicle would probably be charged from its journey, and an expected spark would send 

harmonics dependant on the size of the vehicle (fundamental resonance of 4xlength at max impact probe 

size. The probe is the 2300 kg spent Earth Departure Upper Stage (EDUS) -- about 10m for the Centaur 

rocket -- so the initial pulse might appear at 40 m wavelength, and higher frequencies; 

- lunar dust probably has a stratified electric charge that would generate a noise pulse; 

- lunar dust, like quartz, has triboelectric properties, etc. so electrical discharges would be expected; and 

- lunar dust might accompanied by gaseous emission including water vapor, since the impact will be into 

a dark polar crater. 

  

We must ask if eruptions of such dust can produce electrical effects. The answer is yes. Consider this, a 

2006 photo of Chile's Chaitin volcano, which shows one or two lightning bolts; 

 

Here is Alaska’s Redout volcano on April 14: 
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So I expect that the LCROSS impact might yield a radio pulse with a lower frequency limit of about 7 

MHz followed by a burst of white noise. 

  

Our 15m (20 MHz) monitoring frequency would be an acceptable one to use for LCROSS monitoring, 

and using SkyPipe with accurate atomic clock synchronization, we would be able to identify any detected 

pulses.  

 

We’ve time to do some planning, so start thinking! 

 

UNAM, MEXICO       Stan Kurtz 

 

 

The inclinometer that we bought is a tremendous help in pointing the telescope to the right elevation, and 

with its help we have finally succeeded in detecting the Moon!  (see the figure)  We got started a little late 

in the observing run that is shown, so we were still fiddling around with the sensitivity adjustment when 

the Moon started to go overhead.  But we had everything set before it transited, and got a nice trace as it 

left the telescope beam.  The vertical axis is in volts and the horizontal axis is in seconds.  We were using 
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the Ku-band LNB at this point, and hence were observing at about 10 GHz, with a beam size of about 1 

degree.  

 

 

 

We are still using the satellite finder as our detector.  The tunnel diode detector only needs to have some 

power connections finished, but the student who is working on that is busy with classes right now…. 

We are trying to locate some noise diodes to make a calibration system, and then measure the Allan 

variance of both the satellite finder and the tunnel diode detector. 

 

 

VI.The Basics 

Masers↑ 

The word is an acronym for microwave amplification by stimulated emission of 

radiation. 

The OH and H20 molecules in a giant molecular cloud become powerful sources of 

microwaves as they are excited by radiation from newborn stars. The process starts 

when these molecules absorb photons, whose added energy makes the molecules spin 

faster. In the language of quantum mechanics, the OH and   molecules jump from 
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their ground energy state to an excited rotational energy level, a process called 

“pumping.” 

Higher Energy from Pumping Radiation →  Exited state of OH and  Molecules 

            ↑        ↓ 

           ↑       De-exitation 

               ↑      ---------Meta-stable level---------------   

         ↑                        ↓ 

        ↑                 Maser transition emits micro- 

       ↑      wave photons in a cascade 

           ↑                                                              ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓ ↓  

Lower Energy     Ground state of molecules after transition 

_____________________________________________________________________ 

The excited molecules naturally drop back to a lower energy level by emitting 

photons. According to rules of quantum mechanics, some of these molecules will 

drop down into an energy level that is characterized  as being “meta-stable,” meaning 

that the molecule will remain in that level for an exceptionally long time. 

As a result of the pumping process, regions develop in a giant molecular cloud where 

vast numbers of OH and O molecules are stuck in metastable states. Now imagine 

one of these regions being traversed by a microwave photon whose energy equals the 

difference between the meta-stable excited level and the ground level. The 

electromagnetic field of this photon triggers many molecules along its path to lose 

energy by emitting identical microwave photons traveling parallel to the original one. 

These new photons stimulate still more molecules to lose energy, resulting in a 

cascade that releases a vast amount of energy at microwave frequencies. A single 

maser lasts for only a few weeks or months. Near a site of active star formation, new 

masers are continually being turned on while old ones, having depleted their supplies 

of excited molecules, simply fade away. 

   Reference:  Universe, Fourth Edition; William J. Kaufmann III 

VII.  Notable Quote 
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“There are only two ways to live your life. One is though nothing is a miracle. The 

other is though everything is a miracle.” 

Albert Einstein (1879-1955); German-born American    

Physicist and 1921 recipient of The Nobel Prize in Physics  

 

VIII. A Professional-Amateur Dialogue (Continued) 

 

Rodney Howe writes: 

“I read through the correspondence between Stan and David in the March TAOSON Signal. I 

have to agree with Stan on not having amateurs trying to compete with professional astronomers. 

I looked up Troland, and C. Heiles references, and can see just how much has already been done; 

http://www.pa.uky.edu/~aips/PAGELINKS/trol_publ.hmtl. 

I also think it is a good idea to follow Stan’s lead on looking at Mira masers, especially at the 

OH frequencies, around 1.612 GHz to 1.665 GHz. So, I thought I would put together a proposal 

for doing just that, as described below. 

MIRA LASER PROPOSAL 

The objective of this research will be to detect OH masers around old Mira stars, which in the 

Northern Hemisphere can be found around UHer, S CrB, W Hya, and R Cas. For radio 

measurements with amateur dishes, we’ll have to use dark skies as a control measure of cold sky 

between 2 and 3 degrees off from these Miras. This will be a program for collecting data over a 

couple of years or more. Miras are old variable red giants with an average period of 331 days. 

However, their magnitudes may vary from a visual minimum magnitude to greater than 4 or 5 

magnitude increase (very bright). The hope is that we can detect their OH masers at 1.612 GHz 

and 1.665 GHz.with circular polarization during the entire cycle of variability. If detection is 

possible with a sensitive receiver, perhaps the Spectracyber combined with the 18 meter dish, 

then data can be collected on the weekends or whenever the stars are above the horizon. Variable 

stars are normally done in the optical; however, these OH masers have been rated at greater than 

1 Jansky in flux (see article: Astrometry of The OH Masers of Four Mira Stars). Previous 

calibrations with DSES SpectraCyber, 1.420 GHz receiverhave shown that this is about the limit 

of sensitivity for our 18 meter dish. But with suitable tracking capability, and dwell time, we 

may be able to detect these OH masers signatures. What we don’t know is whether the 

sensitivities between the OH frequencies and the HI frequencies are comparable. Should our data 

be significant, the hope will be to submit our results to the AAVSO Mira Program: 
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http://www.aavso.orh/vstar/vsots/archive.shtml. This would certainly be a first, since there are no 

radio observations of Mira stars in the AAVSO database of variable stars. 

Below might be an observation schedule for the ‘weekend warriors’ at DSES: 

ELEVATION OF MIRA STARS IN DEGREES  AT 1:00 P.M. IN THE MIDDLE 

SUNDAY OF EVERY MONTH, 2009. (Values in Parentheses are Below The Horizon) 

2009 Month    R Cas         RCrB               U Her        W Hya 

January               46                         40                           42                       (-7) 

February             63                         20                           21                       (-37) 

March                 77                         ( 1 )                        ( 1 )                     (-58) 

April                   69                         (-15)                       (-19)                    (-77) 

May                    52                          (-21)                       (-29)                   (-65) 

June                    31                          (-15)                       (-27)                   (-39) 

July                    17                           (-2)                         (-14)                   (-19) 

August               ( 6 )                          19                          ( 2 )                    ( 3 ) 

September            ( 2 )                       40                          28                       15 

October                ( 5 )                        61                         48                       21 

November            16                          77                          67                      14 

December            30                           62                         62                        1 

 

Perhaps we can get some ideas on how this might best be done. The difference between these 

studies and the ones at HRAO (http:www. Hartrao.ac.za/spectra/SP_Ohir.html) will be as 

follows: we would like to do this with a Vertical and Horizontal polarized feed. The science in 

this case would be to see if there are any detectable differences in the polarization among any of 

these Mira stars. And, if so, what does that mean? Any ideas on how to best approach this would 

be helpful. I think we will need to develop computer programs for the Stokes parameters to 

reduce this data. Can this be done effectively without interferometry. i.e. on a single dish? “ 
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In response, Stan Kurtz and David Fields write their comments with some additional ideas 

from Rodney inserted. 

Stan:  In summary the proposal suggests the following: The objective of this research will be to detect OH 

Masers around old Mira stars. This will be a program for collecting data over a couple of years or more. 

Mira stars are old variable red giants with an average period of 331 days. However, their magnitudes may 

vary from a visual minimum magnitude to greater than 4 or 5 magnitude increase (very bright). The hope 

is that we can detect their OH masers at 1.612 GHz and 1.665 GHz with circular polarization during the 

entire cycle of variability.  Should our data be statistically significant, the hope will be to submit our 

results to the AAVSO Mira program: http://www.aavso.org/vstar/vsots/archive.shtml. 

Both David and Stan like this idea.   

David: I like the suggestion of complementing the radio observations with optical data--I'm thinking that 

the Mira stars could be a nice challenge for Roy Morrow’s new optical scope and that they would 

complement a radio effort. Heather is doing photometry on a Mira star; if we could extend this coverage 

to several other targets, then we could document photometric (optical vs radio) changes of Mira stars 

during a cycle or two. 

Rodney adds to this: Heather, perhaps if you have a good telescope on a stable mount, you might think 

about using the SSP-4 IR photometer for these Mira maser stars.  Comparing the IR response and the 

radio signatures might be more useful than just comparing the optical to the radio signatures. 

There was also some discussion of which stars to observe. 

Rodney: In the Northern Hemisphere these masers can be found around:  

U Her, S CrB, W Hya, and R Cas. 

Stan: Some sources that are a bit stronger (and might be good ones to start with) are R Crt, W Hya, and 

IRC+10420.  Particularly the 1665/1667 lines in W Hya can be over 10 Jy. (Although when Chapman 

et.al. (1994) observed it in 1984, it also was down around 2 Jy.  And IRC+10420 has been over 100 Jy in 

the 1612 line. 

David: Up to 100 Jy emission intensity would be great, but the OH/IR stars might be challenging to see 

optically, which puts them more out of reach of the optical folks.  Granted, they should show infra red 

emission. 

Stan: Agreed. For the 'final' study it would be better to use more accessible sources, for which we can 

have a more complete data set.  But the strong ones can at least serve as a test bed to get the radio 

observing techniques down, and as an on-going consistency check of the observations.  It is probably the 

mid-IR that is pumping the OH masers, so it would be most interesting to extend the data coverage in that 

direction.  But having the optical data would be good anyway, to have a stellar tracer. 

Editor’s Note: Others are invited to become involved in this project. Contact David Fields, who will be 

coordinating the various aspects of the study, if you are interested. 
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VIII.Article by Guest Contributor  

Procedures for Making 

Radio Spectrum Observations of the Sun 

Employing the AR5000 Receiver & SDR-14 Spectrum Analyzer 

 

by 

Michael Rudolph 

 

Abstract 

This article describes a solar radio telescope and operating procedures that employ an AR5000+3 

broadband radio receiver that is connected to an SDR-14 software-defined spectrum analyzer.  It also 

describes procedures for displaying, recording, reviewing, and calibrating numerical data acquired there 

from. 

Introduction 

For an amateur radio astronomer with limited financial means, deciding which receiver and spectrum 

analyzer to incorporate in the radio telescope can be a challenging task. A professional radio astronomer, 

operating under a research grant or contract, does not usually have this problem because the intended 

study is defined, and the equipment needed to achieve it is also defined.  What is more, the equipment is 

paid for by the grantor, so the way it may be used at the conclusion of the study is not an issue. 

Not so with the amateur radio astronomer who typically purchases his equipment early in his scientific 

pursuit, at a time when he is not totally sure what his future studies and equipment needs will be.  That, 

plus the fact that the burden of purchasing the equipment is his own,  the amateur radio astronomer must 

think ahead, and purchase equipment that is not only affordable, but that has the greatest foreseeable 

application for future use. 

I recently faced this decision.  I knew I wanted to do spectral studies of the active sun, but I had not yet 

settled in on a specific study or on the range of frequencies I would be observing.  Not only that!  What if, 

in the future, I shifted my observing interest to something else – say to the emissions of Jupiter?  I was 

reluctant to purchase equipment that was so specialized that it could not be used in a wide arena of 

possibilities. 

It came to my attention that Richard Flagg recently purchased two items of equipment that, when working 

together, might have the breadth of possible uses I was looking for.  What is more, Jim Sky had written 

software that could be used with those pieces of equipment to observe and record spectra of the sun, 
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Jupiter, and even deep space emitters.  The equipment consisted of an AR5000+3 (AOR broad-band 

receiver), with its IF output fed into an SDR-14 (RF-Space’s software-defined spectrum analyzer).  After 

communicating with representatives of the two companies, and barraging Jim.Sky and Richard Flagg with 

questions, I concluded that the combination of those two pieces of equipment would most likely do the 

job and, if they didn’t, at least I would be in good company. 

So I took the plunge and purchased an SDR-14 and an AR5000+3, and very soon realized that I had been 

given very good advice, and had hit the jackpot of unbelievable versatility for a modest (by scientific 

equipment standards) cost.  However, learning to use the equipment was another thing.  As I poured over 

the various manuals that accompanied the two pieces of equipment, I perceived that it would take me a 

long time to learn all of their various features and ways they could be used, and that I needed to decide 

upon and become comfortable with one standard setup and one set of procedures that would get me 

started.  I therefore decided to define an initial project, determine a setup and procedures for that one 

project, and leave the future to the future.  When I accomplished that to my satisfaction, I decided to write 

this article describing the specifics of my setup, in the hope that I may spare others who acquire the same 

equipment, the time and anguish I experienced while trying to understand. 

Equipment Overview 

This article describes my setup for receiving and recording 10 MHz-wide solar spectra centered on a quiet 

frequency band chosen between 120 and 150 MHz.  I chose to observe in the VHF region rather than in 

HF because of the convenience of using a smaller antenna, and also because most of the solar data thus 

far acquired has been at HF frequencies.  I chose a 10 MHz bandwidth of study because the AR5000+3’s 

IF bandwidth is nominally 10 MHz.  The rate of spectrum captures per second is limited by which 

spectrographic software one uses to display and save the SDR-14’s data output.  Two software packages I 

compared were (1) “SpectraVue,” developed by Moe Wheatley specifically for the SDR-14, and (2) 

“Rado-Sky Spectrograph,” developed by Jim Sky for a different purpose, but later adapted for use with 

the SDR-14.  My equipment also incorporates a log periodic antenna of suitable frequency, a “Yaesu” 

alt/az rotator driven by “Nova for Windows” solar-tracking software, an “Angle Linear” 21 dB low noise 

preamplifier, and a VHF signal calibrator designed and made by Richard Flagg. 

Each of the spectrographic software applications mentioned has its strengths and its limitations, and each 

has different features.  SpectraVue utilizes more of the features of the SDR-14, it can capture a greater 

number of FFT frequency channels in a given spectrum, its various displays are more varied and more 

refined, and it can be calibrated to display and save data in dBm units.  It is, however, limited in ways that 

make it overall less suitable for spectral studies in radio astronomy -- ways such as its data-recording rate 

being no faster than 1 capture per second, and it’s saved numerical data not being time-stamped.  In 

comparison, Radio-Sky Spectrograph’s capture rate is approximately 10 captures per second, and its 

saved numerical data is automatically time-stamped using the computer’s clock.  It has many other 

favorable features as well, especially its high-speed movie review feature.  Its chief limitations are that it 

can only capture 200 FFT frequency channels of any given spectrum (this is far short of the number of 

FFT channels SpectraVue can capture), its displays are less refined, and its numerical data are not 

expressed in dB units and are not calibrated.  In the balance of things, however, these deficits are a small 

price to pay, when you consider that Radio-Sky Spectrograph does so many other astronomy-related 
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things better than SpectraVue.  My first choice of spectrographic software is therefore Radio-Sky 

Spectrograph, but I find SpectraVue very useful for supplemental tasks.  

As I have said, the AR5000+3’s 10 MHz IF bandwidth limits the observer to spectra that do not exceed 

10 MHz in width.  There is a way around it though; since the SDR-14 can display a 30 MHz bandwidth 

and the AR5000+3 has sophisticated channel-scanning capabilities, it is possible (albeit clumsy) to scan 

and record three adjacent 10 MHz wide spectra, and then piece them together to produce a spectrum 30 

MHz wide.  I did it successfully, but the labor of doing it is, in my opinion, prohibitive.  

Hardware Connections 

The log periodic antenna I use contains 10 elements, and is cut to present a relatively flat 50 ohms at 

received frequencies from 105 MHz to well over 1 GHz.  The antenna is mounted on a Yaesu alt/az 

rotator that tracks the sun, and is connected, via 50-ohm low-loss coaxial cable, to a 120-150 MHz, 21 dB 

gain, low noise preamplifier that is situated adjacent to the other receiving electronics, in a relatively 

temperature-stable control room.  The preamplifier is connected, via a short length of 50-ohm coaxial 

cable, to Antenna Input #1 of the AR5000+3, and the IF output of the AR5000+3 is, in turn, connected, 

via a short length of 50-ohm coaxial cable, to the SDR-14’s Input Channel #1.  Finally, the SDR-14 is 

connected, via a USB cable, to the observatory’s Pentium 4 computer running Windows XP.  Radio-Sky 

Spectrograph, Radio-Sky Pipe, and Microsoft Excel software reside on the computer.
1
 

 

 

AR5000+3 Settings 

The AR5000+3’s receiving parameters are set as follows: 

RF Gain: Squelch off, and RF Gain control fully rotated to the left (maximum gain) 

AGC: Off 

Step: 500 KHz 

Ant: Set to “1” (Assuming antenna connected to Antenna Input #1) 

Att: 0 dB (Unless attenuation is needed beyond that provided by the SDR-14) 

Lamp: Off (Use “Config” button)  (Turned off to conserve light bulb) 

Ext IF: 1 (Use “Config” button) 

BPS: 9600 (Use “Config” button) 

                                                      
1
 Hint: Load Radio-SkyPipe on the computer before loading Radio-Sky Spectrograph 1.7.2; SkyPipe contains a 

needed file. 

. 
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Setting other parameters is not needed. 

SDR-14 / Radio-Sky Spectrograph Settings 

Radio-Sky Spectrograph software (version 1.7.2) that is loaded on the computer controls the SDR-14; the 

software parameters are set as follows: 

Menu Parameters 

View: Show SDR-14 Controls 

Color: Multiply 

 Load Color File (blueyellowred.txt) 

Mode:   Stand Alone 

Options: Identity:  Fill in local data 

 Radio:  Select “SDR-14” 

 Network:  No selection 

 File Saving: Save on Demand 

 Data Directory: Browse and select directory for saved data files 

    Select “Log Saved Files” 

File Review: Above Normal 

Auto Start Server: <No selection> 

Stalls:   0 

Parameters to Right of Chart 1 

Hi F: 15.7 MHz  (Center frequency of AR5000+3’s IF output is 10.7 MHz.) 

Lo F:   5.7 MHz  (Center frequency of AR5000+3’s IF output is 10.7 MHz.) 

Radio: No entry 

SDR-14 FFT Parameters 

Size:
 2
 32768 

Avgs:
 3
 25 

                                                      
2
 The smaller the FFT Size, the higher is the background level for a given signal, and the smaller is the signal-to-

noise ratio. 
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HF Gain: -1  (But set to highest level that does not cause SDR-14’s overload light to blink.)
4
 

Pre Amp: Selected 

Max dB: -10    (Experiment to achieve maximum dynamic range.) 

Min dB: -130  (Experiment to achieve maximum dynamic range.) 

Color Parameters 

Color Offset: Set according to preference (Try beginning at 472, and see following sections.) 

Color Gain: Set according to preference (Try beginning at 0.5, and see following sections) 

Considerations for Setting Radio-Sky Spectrograph’s Color Parameters 

The color settings of Radio-Sky Spectrograph do not affect its saved raw data at all.  However, the color 

appearance of the waterfall display is very important for noticing transient solar activity.  No radio 

astronomer stares at his computer screen six to eight hours a day looking for color changes in real-time, 

so the technique of review that I use is to record a movie of the waterfall display and then, that evening, 

play the movie back at high speed so the day’s observation can be reviewed in 15 to 20 minutes.  This 

requires that the color resulting from normal background noise (as displayed by the waterfall) be such that 

the reviewer can easily notice when a signal of interest occurs, stop the movie, and investigate. 

Various color schemes are possible with the Radio-Sky Spectrograph, but the default scheme 

“blueyellowred.txt” of version 1.7.2 is very adequate.  That color scheme progresses from deep blue for 

the smallest signal strength, then lighter blue, then yellow, then light red, and finally dark red for the 

greatest signal strength.  Because the AR5000+3 is not linear or frequency-independent in its signal 

strength reproduction from antenna to IF output, a flat galactic background that is received at the antenna 

will not produce a flat signal at the IF output across its 10 MHz bandwidth.  Consequently, the waterfall 

display of the radio’s IF will almost always show a gradation of color from its center to both edges, where 

the center is generally higher in signal strength.  This is not a matter for concern because the calibration 

procedure described later in this article compensates for any lack of linearity. 

As a day’s observation is being replayed at high speed, I look for color changes from the background that 

would represent even brief bursts of solar activity.  My task is therefore to adjust the waterfall’s color so 

as to be able to see such activity at the lowest levels.  With the “blueyellowred.txt” color scheme selected, 

I adjust the Color Offset and Color Gain until the center area of the waterfall display is substantially 

yellow with the briefest touches of red, and both its edge areas (top and bottom) contain some blue.  The 

Gain parameter controls color intensity, and the Offset parameter controls color shift toward either blue or 

red; the settings are a matter of personal choice.  The “Max dB” and “Min dB” parameters not only affect 

display color, but also the dynamic range of the saved numerical data; they are discussed in more detail 

below. 

                                                                                                                                                                           
3
 The smallest Avgs setting is 1.  The lower the Avgs, the greater and spikier the background noise (especially at low 

signal levels), but the better the spectrograph is able to capture and display a rapid change in signal strength.  Setting 

Avgs to 5 and higher smooths out the background noise, and improves the signal-to-noise ratio.  I find 25 the best. 
4
 Additional RF gain and attenuation can be obtained via the AR5000+3’s controls. 
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There is another color system that one may use that produces a single-color (no detail) waterfall when 

there is no signal of interest.
5
  This is implemented by right-clicking Chart #2 (the lower display) during a 

time of no solar activity; immediately upon doing so, the color displayed by each FFT frequency channel 

offsets itself to the color of the channel exhibiting the lowest signal level; this immediately causes all 

channels to be displayed in the same color.  The theory here is that an increase in signal in any channel 

will be seen in a contrasting, easily distinguishable color, so it is meant as an alternative to other color 

schemes.  To reset all color offsets to zero, click the menu item of that name in the “Color” drop-down 

menu. 

Starting and Stopping Data Capture and Waterfall Display 

1. Power up the AR5000+3, the SDR-14, and the computer. 

2. Open Radio-Sky Spectrograph 1.72 (or higher) on the computer. 

3. In the View menu, click “Show SDR-14 Controls.” 

4. Set all parameters as previously indicated.  

5. Click the “Start” button (Waterfall starts, but data is not recorded). 

6. Click the “Start Saving” button (The waterfall has already begun; recording of data begins now). 

7. When the observation is finished, click the “Stop Saving” button (Recording stops and data 

is saved as a file with an “SPS” extension). 

8. Click the “Stop” button (The waterfall display stops moving). 

High Speed Review of Data 

As I have previously said, “No radio astronomer stares at his computer screen six to eight hours a day 

looking for color changes in real-time.  The technique of review is to record a movie of the day’s 

waterfall display and then, at the end of the day, play the movie back at high speed so that the day’s 

observation can be reviewed in 15 to 20 minutes.”  When something is noticed in the fast-running movie 

that is of interest, the display is stopped, and the first and last time stamps on the display are noted for 

future reference.  The movie is then resumed, stopped, and started, as many times as are needed until the 

movie ends. 

If the movie is stopped because something is seen that is of interest, the next step is to load the data file 

(not re-run the movie), and look for the segment that contains the item of interest. The time stamps that 

were previously noted are used to find the segment and, when it is found, the data of just that segment is 

saved in a separate file.  The importance of producing this separate and smaller file will become apparent 

when it comes time to analyze the data.  

The procedural details to accomplish what has just been described are as follows: 

                                                      
5
 Do not perform the procedure while a signal of interest is visible; doing so will cause the signal to vanish from 

view. 
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Playing Movie to Find Data 

9. With Radio-Sky Spectrograph 1.7.2 (or higher) loaded on the computer, click “Load Data as Movie” in 

the “File” menu. 

10. Browse for the “SPS” file that contains the day’s recorded data and double-click it; the movie begins 

to play at high speed. 

11. Pressing <P> on the computer keyboard causes the movie to pause, and pressing <S> restarts it. 

12. When something is seen in the movie that warrants further exploration, press <Esc>; this permanently 

stops the movie. 

13. Take note of the time stamp on the extreme left of the display, and the one on the extreme right; these 

will be used to locate the same segment of data in the next steps. 

Loading, Isolating, and Saving Data 

14. In the “View” menu, deselect “Show SDR-14 Controls,” and select “Chart Navigation.”  The “Chart 

Navigation” controls replace the “SDR-14” controls. 

15. Click “Load Data” in the “File” menu; browse and select the “SPS” file of interest.  The loaded file 

will appear in the waterfall display.  This is the same file, but not in “Movie” mode. 

16. Now click the left-hand button that contains the “pencil” icon.  This launches a box in which you can 

manually enter “Start” and “End” times that were the end-points (time stamps) of the waterfall 

segment of interest you noted in the movie. 

17. Enter the “Start” and “End” times you desire and click “Save” (This records the segment end-points; it 

does not save the file).  Notice that the segment that was observed and noted earlier in the movie is 

now fully displayed, but the rest of the file is still there and can be observed by navigating left and 

right. 

18. Navigate the timeline (left and right) of the displayed waterfall segment to more precisely determine 

the beginning and end of the data segment you want to study and save.  This is done using the 

navigation buttons that are among other Chart Navigation controls. 

19. Take note of the chosen segment end-points and their time stamps, add a few seconds to each end of 

the segment, and repeat instructions 16 and 17 above, except with this revised segment – not the one 

previously noted in the movie. 

20. Save the displayed segment of data to a new “SPS” file by clicking the button to the far right in the 

Chart Navigation controls.  You will be prompted to select a destination folder, and a name for the 

file that will be saved, and that will contain the data segment of interest.  It will, of course, be smaller 

than the original “SPS” file from which it was taken; that is the point. 

Exporting Spectrograph Data to an Excel Worksheet 
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The spectrographic data of interest has been saved as a new “SPS” file, but two additional steps are 

needed before the numerical data can be accessed for analysis.  Those two steps are (1) export the “SPS” 

file to a “CSV” file, and (2) load the “CSV” file into a Microsoft Excel Worksheet.
6
  To accomplish these, 

do the following: 

21. In the “File” menu, click “Export to CSV File / Export All.”  

22. Browse for a suitable folder, type in a suitable file name, and click “Save.” 

23. Double-click the “CSV” File that was produced; it is displayed in the form of an Excel Worksheet, but 

the file still has a “CSV” extension. 

24. To convert the displayed “CSV” file as an Excel 2007 Workbook file with an XLSX extension, click 

“Save As / Excel Workbook” in Excel’s Office Button dropdown menu. 

25. Browse for a suitable folder, type in a suitable file name, and click “Save.”  The data is now saved as 

an Excel 2007 Workbook. 

Need and Procedure for Calibrating the Data 

As I previously indicated, the numerical data contained in the “CSV” file that Radio-Sky Spectrograph 

produces is not calibrated.  Not only that; the equipment used to receive, amplify, filter, digitize, and 

finally record the numerical data all contribute to nonlinearity of the final data as compared with the 

original signal; hence the need to calibrate the data against an external standard. 

 

There are several approaches to this, but I chose to interpret the power data produced by Radio-Sky 

Spectrograph as equivalent radiation temperature using a VHF Calibrator that was made for me by 

Richard Flagg.
7
 

The steps I take to calibrate my data are as follows: 

26. Once the data segment of interest has been isolated, saved, and displayed in an array as 

previously described, I note the maximum and minimum numerical data (the data that ranges 

from the galactic background to the most intense signal of interest) in each FFT frequency 

channel I will be analyzing.  Two hundred channels of data are automatically recorded, so if I 

want to use them all in any analysis, I must either calibrate them all or be willing to extrapolate 

over multiple contiguous channels.  Extrapolation works reasonably well near the center of the 

10 MHz wide recorded spectrum, but it does not work well toward the edges of the spectrum 

because there is less linearity near the edges. 
 

27. Without altering the equipment, the equipment settings, or the software parameters with which I 

originally observed, I disconnect the antenna from the preamp and replace it with the Flagg VHF Signal 

                                                      
6
 Excel 2007 or later is recommended in order to have the advantage of its large number of rows and columns. 

7
 Signal Calibrators for a variety of frequencies can be made to specification by Richard Flagg, through his company 

RF Associates. 
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Calibrator.
8
  The Calibrator employs a known noise source and a pair of precision attenuators that can be 

dialed up or down in 1 dB steps to produce broadband noise of known temperature in the VHF band I am 

using.  

28. With the noise generator of the calibrator turned on, I make short recordings in Radio-Sky 

Spectrograph adjusting the calibrator’s attenuators so as to reproduce the range of numerical data that are 

of interest that appear in each of the FFT frequency channels to be analyzed.  

29. From the above procedure, I generate a calibration table where each column is an FFT frequency 

channel that I intend to analyze, each row is a number that is in the range of expected data generated by a 

typical observation recorded with Radio-Sky Spectrograph, and each intersecting point is a corresponding 

temperature (in Kelvins) derived from the Flagg VHS Signal Calibrator. 

30. Using the above table as a reference, I replace all of the Spectrograph-generated data numbers that are 

of interest in a particular observation with their corresponding Calibrator-generated temperatures. 

The result is an array that contains calibrated temperature data of the spectrum segment of interest.  The 

data can now be analyzed for spectral details or computed into a continuum. 

Summary and Looking Ahead 

I submitted this article for publication in the TAOSON Signal because I believe its details of equipment 

choice and operation will be appreciated by the Signal’s hardware-oriented readership – especially those 

who own all or part of the equipment I have described, or who are currently in the process of choosing 

which equipment to purchase.  To those who are deliberating on the purchase of equipment, I heartily 

recommend the AR5000+3 / SDR-14 combination for receiving, digitizing, and computer interfacing, 

Radio-Sky Spectrograph for spectrum capture, display and recording, and a Flagg Calibrator (or its 

equivalent) for signal calibration.  

Although my target of interest is the sun and the spectra I am observing is in the VHF range, the 

equipment I am using and have described is fully adaptable to other targets and other frequencies.  In my 

saying this, do keep in mind that, for applications below 30 MHz, the SDR-14 may be sufficient without 

the AR5000+3 as its front end. 

I am now looking forward to the sun becoming more active so that my next article can be a report of 

interesting spectral data.  
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8
 The Flagg VHF Signal Calibrator was itself calibrated prior shipping, and a chart of “dB” vs. “Temperature 

(Kelvin) was provided for signals of 120 MHz, 130 MHz, 140 MHz, and 150 MHz. 


